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you were interrupted.
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e same exercise.

 make a mistake, and
posed to.

and then select Start > 
> Reset Tutorial Data. 

he exercises.

ave a backup for each 
. Keep your backups in 

Note

The data in the tutorial 
might differ from the 
examples.

Note

Technical Support 
does not provide 
assistance on your 
backup procedures.
PracticeWorks Charti

troduction

u can use this workbook to become acquainted with the 
acticeWorks Charting Module, a Sensei product, before, 
ring, and after training. 

kill Sharpeners

e software comes with a tutorial, which contains data. The 
ercises in each lesson enable you to use the data and add 
ur own. After you complete the exercises, you can reset the 
orial data to its original state. 

e the PracticeWorks Software Tutorial to do the skill 
arpeners. 

ccessing the Tutorial

 access the tutorial:
Click Start > All Programs > PracticeWorks > Tutorial > 
Tutorial. The Employee Login window is displayed.

In the Your initials field, type JEK.

In the Password field, type 1234.

Click OK. The Practice Central window is displayed. 

To close Close Practice Central, click the X. The 
Appointment Book window is displayed.

Resetting the Tutorial Data

Reset the data in the tutorial when:

• You have completed an exercise, b
again.

• You have started an exercise, but 
You are not sure at what point you
so you decide to start over.

• You have completed an exercise, b
your office needs to practice on th

• You are doing an exercise, but you
the data does not look like it is sup

To reset the tutorial data, close the tutorial, 
All Programs > PracticeWorks > Tutorial 
The reset data utility runs.

Be sure to reset the data when you begin t

Backing Up Data

Back up your data every day. You should h
day of the week, with copies stored off-site
a fire-resistant safe. 
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 the Practice Central 
ointment Book 

ment Book window or Note

Displaying the Practice 
Central window is a 
Miscellaneous defaults 
option. 
PracticeWorks Char

sson 1
avigating the PracticeWorks Charting Module

is lesson includes:

• Accessing Charting on page 1 

• Closing Charting on page 4 

• Understanding the Components of Charting on page 4 

• Accessing Images on page 5

ccessing Charting 

 open the PracticeWorks software:

Select Start > All Programs > PracticeWorks > Tutorial > 
Tutorial. The Employee Login window is displayed. 

For the software tutorial, type JEK in the Your initials field 
and 1234 in the Password field. 

Click OK. Typically, the Practice Central window is displayed. 

4 Click the X in the upper-right corner of
window to close the window. The App
window is displayed. 

You can access Charting from the Appoint
the patient’s clipboard. 



 whose chart you want to see. 

board is displayed. 
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To access Charting from the Appointment Book: 

1 Find an appointment you and right-click. The Appointment 
Book Short-Cut Menu is displayed: 

2 Click Charting Module. The chart is displayed.

To access Charting from the Phone Inquiry icon: 

1 Select the Phone Inquiry icon from the toolbar. 
The Select person on the phone window is displayed.

2 Select the patient

3 Select Edit. 

4 Click OK. The clip

5 Click Chart. 

Phone Inquiry
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PracticeWorks Charti

The chart for the patient is displayed. 



 to organize, view, and print different 
her. You can also integrate x-ray and digital 
 single presentation.

rea is on several of the tabs. 

harting, the Displayed Visit area shows the 
isit number. If this is the first time you have 
you have never charted anything for this 
 Visit area indicates that this is visit 1 of 1. If 
 to the chart, when you exit the software the 
isit is created when either an entry has been 
note has been entered.

thing for a patient, the chart is saved. The 
hart for the patient, the Displayed Visit area 
isit 2 of 2. Use the <<Prev>> and 
 move through the charts.

nd Soft tissue tab have separate charts. If 
ry on the Hard tissue tab (composite, 
it creates a new soft tissue chart as well, 
ng was done. 

 the hard tissue charts without any actual 
of charts vary.
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Closing Charting

To close Charting and return to the practice management 
software, click Close Chart. 

Understanding the Components of Charting

When you access Charting, the Hard tissue tab is active by 
default. Charting consists of the following tabs:

• Hard tissue—Used to document all pathologies and 
conditions, missing teeth, restorations, existing 
procedures, completed treatment, proposed treatment, 
clinical notes, forms, and prescriptions. 

• Soft tissue—Used to enter the current periodontal 
condition of the patient, to view previous periodontal 
conditions, and to compare the periodontal conditions on 
different dates.

• Prog notes—Displays exam results, completed dental 
treatment, proposed treatments, and so forth. You can 
sort the entries by date or area. If you sort by area, the 
progress notes are grouped by tooth number, quadrants, 
and area of the mouth. 

• Tx Plan—Displays the procedures in one or more 
treatment plans that have been, or will be, presented to 
the patient. The term treatment plan is abbreviated as 
TxPlan on tabs and buttons.

• Attach(ed) img—Used to attach images to the patient’s 
chart and to view existing attached images.

• Capture—Acquires images from external devices and 
associates them with a patient’s chart.

• Layout—Used
images toget
images into a

The Displayed Visit a

Each time you open C
current date and the v
seen the patient, or if 
patient, the Displayed
you make no changes
chart is not saved. A v
made on a chart or a 

When you chart some
next time you open a c
indicates that this is v
<<Next>> buttons to

The Hard tissue tab a
there is a charting ent
crown, and so forth), 
even if no perio charti

If note entries exist on
charting, the number 

Important

Multiple users can now 
update a patient's 
record at the same 
time; the changes are 
saved, but the record is 
not refreshed 
automatically. If multiple 
users change the same 
field, only the most 
recent change to that 
field is saved.

Note

On most tabs, the Post 
Work button becomes 
active when you add a 
new procedure.
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is displayed on every 
, and the Capture tab. 

ntegrates with 
 See your Carestream 

t is shared by 
applications. If an 
g applications, it can 

Note

The Arch/Quad view 
is referred to as a 
pictograph.
PracticeWorks Char

The Hard tissue tab, the Soft tissue tab, the Prog notes tab, and 
the Attach img tab display the Arch/Quad view. 

To see all progress notes for an area, right-click the area of the 
Arch/Quad view and select All Progress Notes.

The Image Viewer is displayed on the Hard tissue tab, the Soft 
tissue tab, the Attach img tab, the Capture tab, and the Layout 
tab. 

Information about the patient is displayed on several of the tabs. 

A portrait of the patient, if one is available, 
tab except the Tx Plan tab, the Layout tab

Accessing Images

The PracticeWorks Charting Module now i
Carestream Dental’s CS Imaging software.
representative for more information.

Images are stored in a single database tha
PracticeWorks, Charting, and the imaging 
image is modified in Charting or the imagin
be viewed in any application that uses it. 



 Number of Prior Visits

visits Ray Adkins has had before today for 
w many perio visits has he had before 

ber of hard-tissue visits and soft-tissue visits 
usly had:

’s chart. By default it opens on the Hard 

ay Visit area. It says this is visit 4 of 4. 
s had 3 previous visits.

sue tab. The Soft tissue chart is displayed. 

ay Visit area. It says this is visit 3 of 4. 
s had 2 previous perio visits.
6 of 6  PracticeWorks Charting Module Training Workbook (DE255-05)

Skill Sharpeners—General Navigation

Exercise 1—Determine the Software Version

You have a question about Charting that you cannot find an 
answer for in Help, so you call technical support. The support 
person asks what version of the software you are using. How do 
you find out what version of Charting you have?

To determine your version of Charting: 

1 In the PracticeWorks Charting Module, click the About button 
in the upper-right corner of any window. The About window is 
displayed. 

2 Make a note of the version number listed in the window.

3 Click OK.

Exercise 2—Open a Patient Chart

Ray Adkins has an appointment this morning at 8:00 A.M. From 
your practice management software, open the chart for Ray 
Adkins.

To open the chart:

1 Select Ray Adkins’s appointment at 8 A.M., and right-click. A 
menu is displayed. 

2 Select Charting Module. Charting opens, displaying the 
chart for Ray Adkins.

Exercise 3—Find the

Determine how many 
non-perio reasons. Ho
today?

To determine the num
the patient has previo

1 Open Ray Adkins
tissue tab. 

2 Look at the Displ
Therefore, Ray ha

3 Click the Soft tis

4 Look at the Displ
Therefore, Ray ha
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e on your screen. For 
800 X 600, the 
—in the lower-right 

an area of the mouth. If 
ver, the progress notes 

ntrol Panel window is 

Note

The resolution also 
needs to be 
configured in the 
PracticeWorks 
software.
PracticeWorks Chartin

sson 2

sing the Hard Tissue Tab

is lesson includes:

• Configuring options
• Changing screen resolution
• Understanding the Hard tissue windows
• Printing the hard tissue chart
• Sharing entries among tabs

onfiguring Options

 configure colors, materials, and other settings for the Hard 
sue tab: 

Select Start > All Programs > PracticeWorks > 
Configuration of Charting Module. The Configuration of 
Charting Module window is displayed. 

Select Setup > Hard tissue. The Hard tissue menu is 
displayed. 

Select from the list of options.

4 Click OK to save each setting.

5 Select File > Exit to close the window

6 Restart Charting to see the changes.

Changing Screen Resolution

Screen resolution controls what you can se
example, if your screen resolution is set to 
progress notes area of the Hard tissue tab
quadrant—displays the history of a tooth or 
your resolution is set to 1024 X 768, howe
display the history of the entire mouth.

To change screen resolution:

1 Select Start > Control Panel. The Co
displayed.

2 Double-click Display. 

3 Click Adjust resolution. 

4 Adjust the settings, and click OK.
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Understanding the Hard Tissue Window

When you open Charting, the Hard tissue tab is selected by default. 
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 are displayed: 

 displayed: 

 displayed: 

 displayed: 

able, including Bridge, 

Note

By default, charts for 
patients under 10 
years of age 
automatically display 
deciduous teeth. The 
age, however, can be 
customized. This 
enables you to track 
the loss of primary 
dentition. 
PracticeWorks Chartin

The Hard tissue window is made up of the following areas: 

• Tooth chart
• Charting palettes
• Charting modes
• Progress notes

Tooth Chart

The largest part of the window displays the tooth chart, in which 
you select individual teeth for charting. 

Charting Buttons

Charting buttons can be configured to your preferences. 

Below the tooth chart are the Charting palettes, which display 
buttons to document restorations and conditions for a tooth, 
quadrant, or area of the mouth. 

At the top of the toolbar are four tabs—Hygiene, Basic, Major, and 
Other. These tabs can be customized.

Select Hygiene, and the following buttons

Select Basic, and the following buttons are

Select Major, and the following buttons are

Select Other, and the following buttons are

Over forty system-defined buttons are avail
Fracture, Impacted, and Sealant.



ropriate Charting Mode

ing modes: 

 mode, select the option. 

ting Mode

ccurred in the past. The first time you chart 
new patient, you are asked to enter the date 
sit. If the date you enter is today’s date, the 
 the patient’s first visit to your office, and 
uted to Other office.

tered, the system assumes you are updating 
and prompts you for the date and producer 
 not the patient’s first visit, and you enter a 
, the Service Date for Existing Entry 
ach time you make an entry. Click OK to 
ns for the current visit. 

day’s date, selected an in-house producer, 
e to Chart existing, the system considers 
 to be Chart completed. A window is 
ou that the existing work is considered 
w also displays at the beginning of each 
e entry. To avoid this window, switch to 
de for entering work done today.

ways be charted as existing.
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To add a system-defined button to a palette: 

1 Right-click on a blank area of a palette, and a menu is 
displayed. 

2 Select Add Button. The Select Type of Button to Add 
window is displayed. 

3 Scroll through the list to select the button you want to add.

4 Highlight the selection, and click OK. The button is added to 
the palette.

To delete a button:

1 Right-click on the button you want to delete. A menu is 
displayed. 

2 Click Remove Button. 

Selecting the App

There are three Chart

• Existing
• Completed
• Proposed

To choose a Charting

Using the Chart Exis

Existing entries have o
an existing entry on a 
of the patient’s first vi
software knows this is
these entries are attrib

If an earlier date is en
your electronic chart, 
of each entry. If this is
date earlier than today
window is displayed e
enter existing conditio

If you have entered to
and have set the mod
any restorative entries
displayed to remind y
complete. This windo
subsequent restorativ
Chart completed mo

Pathologies should al

Note

You cannot change the 
name or the properties 
of a system-defined 
button.
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Using the Chart Completed Mode

This mode is available only when you begin charting from an 
appointment on today’s date that has not been checked out in the 
system. This limits completed entries to work done today on 
patients who have an appointment today. Completed entries are 
posted back to the Check Out Ledger after the patient’s chart is 
closed. 

Using the Chart Proposed Mode

This mode is used to document specific treatments that you 
propose to the patient. Proposed treatments are displayed in red 
on the tooth chart. The entries also appear automatically on the Tx 
Plan tab, along with the correct ADA codes and related 
information. When you exit the patient’s chart, you are prompted to 
create a treatment plan using the treatments you selected while in 
this mode.

Progress Notes

Progress notes can be displayed per tooth by double-clicking the 
tooth in the tooth chart. To see quadrant-specific entries, 
double-click on the quadrant in the pictograph. To view full-mouth 
entries, double-click Full in the pictograph.

When your screen resolution is at least 10
notes are displayed in the lower-right quadr
tab. 

Progress notes reflect the entries made in 
exam results, completed treatment, and tre

Printing the Hard Tissue Cha

To print the hard tissue chart:

1 Click Print. The Print hard tissue cha

2 Select the elements you want to print, 
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Sharing Entries Among Tabs

The Hard tissue tab interacts with other parts of Charting in the 
following ways:

• Teeth charted as missing on the Hard tissue tab are 
displayed as missing on the Soft tissue tab and 
Attach(ed) Images tab.

• Proposed treatments entered on the Hard tissue tab are 
displayed on the Tx Plan tab. 

• Proposed treatments entered on the Tx Plan tab can be 
converted to a treatment plan on the Hard tissue tab. 

• If a patient has more than one treatment plan, the one 
currently selected on the Tx Plan tab is displayed on the 
Hard tissue tab. 

• If the patient’s portrait is displayed on the Capture tab or 
the Clipboard in the practice management software, the 
portrait is also displayed on the Hard tissue tab.

• Camera icons appear on the Hard tissue tab for images 
that are attached to a specific tooth or area on the 
Attach(ed) Images tab.

• Each entry made on the Hard tissue tab is shown as a 
text entry on the Prog Notes tab. 

• Entries charted as Completed on the Hard tissue tab 
are transferred to the Check Out Ledger when the chart 
is closed.

• The Forms and Notes buttons are the same on the Hard 
tissue tab, the Soft tissue tab, and the Prog Notes tab.
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Skill Sharpeners—Using the Hard Tissue 
Tab

Exercise 1—Printing a Chart

Print the Hard tissue chart and its legend for Ray Adkins. 

To print the chart and its legend from the Hard Tissue tab:

1 With the chart for Ray Adkins open, click the Hard tissue tab. 
The Hard tissue window is displayed. 

2 Click Print on the right side of the window. The Print hard 
tissue chart window is displayed. 

3 Select only Print graphical chart and Print legend. 

4 Click OK. 

Exercise 2—Making Entries

Ray Adkins has a pain in tooth #22. Take an x-ray of the tooth and 
create a note documenting the findings. 

To document that an x-ray has been taken of tooth #22, and 
simultaneously create a note of it:

1 Select Mode Completed.

2 On the Hard tissue tab, click tooth #22. The tooth is 
highlighted. 

3 Click in the Hygiene section of the toolbar. The buttons 
related to hygiene are displayed. 

4 Click X-rays and click OK. The Additional entries for area 
FM window is displayed. 

5 Select Procedure 00220 (Periapical single, first) and click 
OK. The History Entry window reflects the x-ray of tooth #22. 

Exercise 3—Charting a Crack on a Tooth

The x-ray of tooth #22 shows a slight crack
Indicate this condition on the hard tissue c

To chart a crack on the distal surface of too

1 Click the Other toolbar to show the bu
conditions. The Other toolbar is displa

2 Click tooth #22 on the chart. The tooth

3 Click the Crack button. The Service D
window is displayed. 

4 Click OK. The Select cracked surface

5 Click D, and then click OK. The Additi
#22 window is displayed. 

6 Select Sensitivity of tooth, and click O
tooth window is displayed. 

7 Verify that the tooth number is correct,
Attach note to patient chart window 

8 Add the following phrase to the note: C
x-ray. 

9 In the Type area of the window, select

10 In the Show character(s) on section o
Display on hard tissue chart and Dis
chart.

11 Click OK. The Check Spelling window

12 Click Ignore if you have typed the wor
spell check has finished, the Display C
window is displayed. 

13 Click Yes. 
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The Hard tissue tab window is displayed again. A graphical 
representation of the condition is on tooth #22. A note has been 
created and is available for review in the Note section.

Exercise 4—Reversing an Entry

Remove the entry you just made. To undo an entry:

1 Select an entry.

2 Click Correct entry in the lower-right corner of the window. 
The Correct Chart Entry window is displayed. 

3 Select Remove entry, and click Make correction. The Verify 
Remove Entry window is displayed. 

4 Click Yes.
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sing the Soft Tissue Tab

is lesson includes:

• Overview on page 15

• Moving Around the Soft Tissue Tab on page 15

• Understanding the Soft Tissue Window on page 16

• Viewing the Soft Tissue Chart on page 17

• Making Entries to the Soft Tissue Chart on page 19

• Printing the Soft Tissue Chart on page 20

• Recording PSR Scores on page 20

• Sharing Entries among Tabs on page 21

• Viewing Statistics on page 21

verview

e Soft tissue tab is used to enter the current periodontal 
ndition of the patient, to view the patient’s periodontal condition 
 any previous visit, and to compare the patient’s condition on 
ferent visits. On this tab, you can record and display pocket 
pths, bleeding, calculus, suppuration, plaque, and recession 
asurements on six sites per tooth. You can also chart furcation 

d mobility, attached gingiva, and calculus. 

cket depths and recession measurements can be displayed 
parately or combined as total tissue loss. The measurements 
n be shown as a bar graph, a line graph, or numerically. The 

numeric measurements can be displayed a
measurements or as changes from a previo

Click PSR to record a PSR score. 

Moving Around the Soft Tiss

The software charts periodontal conditions

• 1–16 Buccal
• 16–1 Lingual
• 32–17 Buccal

• 17–32 Lingual

When you click a tooth on the Soft tissue 
that tooth is displayed. 

If you use the arrow keys on the keyboard a
active area of the Soft tissue tab, the char
progression outlined above. The Othr point
site behind the charting site. The Other po
to chart bleeding, suppuration, plaque, and

As you make an entry at each site, the poin
move automatically to the next site. 

If you are in Attached Gingiva mode, the <
<<Next>> buttons move you from tooth to
Pocket mode, the <<Prev>> or <<Next>
from site to site. 
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Understanding the Soft Tissue Window

Click the Soft tissue tab, and the Soft tissue window is displayed.



g Module Training Workbook (DE255-05)  17 of 22

area. 

e charting mode, and 

ts for a tooth. 

t

ll Readings, single 
 by default on the 
r of the tooth chart on 

lect other views: 

Note

Typically, you enter the 
depth measurements 
of 1 to 9 with the 
numbers on the 
keyboard.
PracticeWorks Chartin

The Soft tissue window contains the following tooth chart area: 

The following codes for conditions are displayed on the tooth 
chart: 

• Pckt for pocket depth

• Rec for recession

• AttG for attached gingiva

• Furc for furcation

• Mobl for mobility

• Bled for bleeding

• Supr for suppuration

• plaQ for plaque

• Calc for calculus

Below the tooth chart is the measurement 

Use the left side of the window to select th
use the numbers to enter depths. 

The middle section shows the measuremen

Viewing the Soft Tissue Char

The default view of the soft tissue chart is A
visit (data entry). This choice is displayed
drop-down list below the lower-right corne
the Soft tissue tab. 

Click on the drop-down list, and you can se



 displayed on the buccal middle site on 

h, line graph, two visits—The two visits are 
ifferent colors.

umeric, selected visits—Illustrates the 
asurements for up to three visits.

umeric (change), selected visits—Shows 
s in recession measurements for up to three 

ine graph, two visits—Illustrates changes in 
e two visits are displayed in different colors.

loss, numeric, selected visits—Illustrates 
ss for up to three selected visits.

loss, numeric (change), selected visits—
 difference in total tissue loss for up to three 

loss line graph—Illustrates total tissue loss: 
s pocket depth.

lected visits—Shows the bleeding dots for 
sits.

, selected visits—Shows suppuration for up 
.

cted visits—Shows the plaque dots for up to 

lected visits—Shows the calculus dots for 
sits.

 selected visits—Shows PSR scores for up 
.
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The following options are available from the drop-down list:

• No readings (bare chart)—Shows the teeth that are 
present, crowned, bridged, or implanted, and displays 
notes, but does not display perio readings or horizontal 
grid lines at the roots.

• Pocket depth, numeric, selected visits—Illustrates the 
pocket depth measurements for as many as three visits.

• Pocket depth, numeric (change)—Illustrates the 
differences in pocket depths among as many as three 
different visits.

• Attached gingiva, numeric, selected visits—Same as 
Pocket depth, numeric, selected visits, but with 
attached gingiva readings.

• Attached gingiva, numeric (change)—Same as Pocket 
depth, numeric, selected visits, but with attached 
gingiva readings. 

• Furcation, numeric, selected visits—Same as Pocket 
depth, numeric, selected visits, but with furcation 
readings. 

• Furcation, numeric (change)—Same as Pocket depth, 
numeric (change), selected visits, but with furcation 
readings. Displays the readings in appropriate sites on 
each tooth. Some teeth may have no readings.

• Mobility, numeric, selected visits—Same as Pocket 
depth, numeric, selected visits, but with mobility 
readings. There is only one mobility reading per tooth. It is 
displayed on the buccal middle site on each tooth. 

• Mobility, numeric (change), selected visits—Same as 
Pocket depth, numeric (change), selected visits, but 
with mobility readings. There is only one mobility reading 

per tooth. It is
each tooth. 

• Pocket dept
displayed in d

• Recession, n
recession me

• Recession, n
the difference
visits. 

• Recession, l
recession. Th

• Total tissue 
total tissue lo

• Total tissue 
lllustrates the
visits.

• Total tissue 
recession plu

• Bleeding, se
up to three vi

• Suppuration
to three visits

• Plaque, sele
three visits.

• Calculus, se
up to three vi

• PSR Scores,
to three visits
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Making Entries to the Soft Tissue Chart

When charting the patient’s periodontal condition, you have the 
following ways to enter data into the chart: 

• You can click on the numeric keypad on the tab. 

• You can use the number pad or the numbers on the 
keyboard. 

• You can use your electronic probe.

How you see the soft tissue chart depends on the display option 
you select from the drop-down list. When All readings, single 
visit (data entry) is selected, you have the ability to add perio 
chart information. 

To chart the patient's periodontal condition: 

1 Select a producer from the drop-down list to indicate who 
performed the examination.

2 On the Soft tissue tab, select the tooth area to chart. A 
rectangle with pointers appears around the site.

3 In the measurement area, select the condition you are 
documenting from the following options:

• Pckt for pocket depth

• Rec for recession

• AttG for attached gingiva

• Furc for furcation

• Mobl for mobility

• Bled for bleeding

• Supr for suppuration

• plaQ for plaque

• Calc for calculus

4 Enter the measurement of the pocket, 
furcation, or mobility. The location to en
in a blue box. As you move from site to
number location moves also. If you nee
click on the site that needs to be corre
the new number. 

5 Click the buttons on the right of the nu
indicate bleeding, suppuration, calculu
entries appear as icons in the light blue
measurement.

In data entry mode, all measurements on sit
simultaneously.
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Printing the Soft Tissue Chart

To print the soft tissue chart:

1 Click Print. The Print soft tissue chart window is displayed. 

2 Enter the date range for the items you want to print.

3 Select the components you want to print and click OK. 

Recording PSR

The Periodontal Scree
categorizes the teeth 

1 Click PSR. The P
window is display

Numbers with an 
sextant. An X indi

2 To enter the patie
a box, and click th
keyboard. 

3 If the patient has 
<<Next>> to scr
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Sharing Entries among Tabs

The Soft tissue tab interacts with other tabs:

• The patient’s portrait, captured elsewhere in the system, 
is displayed on the Soft tissue tab. 

• Perio entries made to the chart are recorded in the 
progress notes. 

• Certain procedures charted on the Hard tissue tab result 
in the creation of a Soft tissue tab visit. These 
procedures include crowns, extractions, implants, and 
bridges.

Viewing Statistics

To see a summary of a patient’s periodontal exam for a particular 
visit:

1 Click the Statistics button in the lower-right portion of the 
window. The Full Perio Exam Statistics window is displayed. 

2 Select the date of a particular visit by clicking on the Stats for 
visit on drop-down list at the top of the window.
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Skill Sharpeners—Using the Soft Tissue Tab

Exercise 1—Chart a periodontal condition.

To chart Jacob Adair’s perio condition: 

1 Open Mr. Adair’s chart and select JEK from the Producer 
drop-down list.

2 Click the Soft tissue tab and select the tooth area to chart. A 
rectangle with pointers appears around the site.

3 In the measurement area, select Pckt for pocket depth

4 Enter measurements in the blue boxes. As you move from site 
to site on the chart, the number location moves also. If you 
need to change a number, click on the site that needs to be 
corrected, and then enter a new number. 

5 Click the buttons on the right of the numbered keypad to 
indicate other conditions, such as bleeding, suppuration, 
calculus, or plaque. 

Exercise 2—Displaying Summary Statistics

Display summary statistics for Jacob Adair’s periodontal condition 
as of his visit on July 28, 2010. 

To display summary statistics for a periodontal visit:

1 Open Mr. Adair’s chart and click the Soft tissue tab. The Soft 
Tissue Chart window is displayed. 

2 Go to the Display Visit area, and navigate to the 7-28-09 
visit. 

3 Double-click tooth #3. The progress notes for tooth #3 are 
displayed.

4 Click the Statistics button below the Display Visit area. The 
Full Perio Exam Statistics window is displayed. 
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sson 4

sing the Progress Notes Tab

is lesson includes:

• Understanding Progress Notes on page 23

• Using the Progress Notes Window on page 24

• Attaching Progress Notes on page 25

• Correcting Entries on page 26

• Viewing Notes by Tooth or Area on page 27

• Printing Progress Notes on page 27

nderstanding Progress Notes

ogress notes reflect all the entries made in Charting, including 
am results, dental treatment, and treatment plans. When you 
hlight an image entry in the table, a thumbnail of the image is 
played in the Image Viewer.

e following information can be displayed:

• Existing conditions
• Proposed treatment
• Completed dental treatment
• Pathologies
• Missing teeth
• Attached images (camera images, digital radiographs)
• Forms
• Notes
• Soft tissue exams

• Documents
• Contacts

You can sort the list by date or area of the 

The Entry column contains the following ty

• Text entries generated automatical
done on the Hard tissue tab.

• Text entries generated automatical
done in the Soft tissue tab.

• A description for a Note. If a note i
column, the text is displayed in the
bottom of the window.

• A description for a Form. If a form 
column, the details are displayed a
window. 

• ADA codes charted as complete to
be corrected by clicking Correct e

• Treatment plan entries, shown as (
plan). These entries can only be co
tab. 

• Entries imported from the patient le
ledger). These entries can be corr
ledger.

• Corrections made with Correct en
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Using the Progress Notes Window

Click the Prog Notes tab, and the Progress Notes window is displayed.
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Attaching Progress Notes

Progress notes can be created on the Hard tissue tab, among 
other places. Some notes are created automatically; others are 
created manually.

To create a progress note manually:

1 On the Hard tissue tab, select a tooth, an area, or the entire 
mouth.

2 Click Note, located above the Progress Notes/History 
section of the window. The Note Template Pick List is 
displayed. 

3 Select the note to attach, and click OK
window is displayed. 

4 Use the options on the window to ente
and then click OK. The Attach note to
is displayed. 

The Summary, Date, and Note text fie
You can type additional data in the No

5 In the Show character(s) on area, sel
should be displayed: Hard tissue tab, 
Arch/Quad view. 

6 Select whether the note should be an 

7 Click OK. 



ction. The Modify Note window is 

be changed with Correct entry. When you 
 entry, a message is displayed telling you 
rrection:

 Ledger—Corrections must be made in the 
r.

 Treatment Plan—Corrections must be 
Tx Plan tab.
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Correcting Entries

Use the Correct entry button to remove a note or to correct a 
chart date or producer. There is a Correct entry button on the 
Hard tissue, Soft tissue, and Prog Notes tab. Typically, entries 
are corrected from the Hard tissue tab.

To correct an entry:

1 Highlight the incorrect entry, and click Correct entry at the 
bottom of the Entry column. The Correct Chart Entry window 
is displayed. 

2 Select the type of correction you want to make, and enter the 
appropriate information. Changes to the producer, the date, or 
the attached area are made in this window. To edit a note, 
select Edit note contents. 

3 Click Make corre
displayed. 

Some entries cannot 
try to correct such an
where to make the co

• Entries from
patient ledge

• Entries from
made on the 
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Viewing Notes by Tooth or Area

To see notes associated with a particular tooth or area of the 
mouth:

1 Use the Arch/Quad view section of the Prog notes tab, and 
click the tooth or area of the mouth for which you want to see 
the associated notes. A small rectangular box defines the 
area. 

2 Double-click the rectangle, and the Progress Notes for [area 
you selected] window is displayed, which lists all items—
notes, forms, watches, and alerts—associated with that area. 

Printing Progress Notes

To print information from the Prog Notes ta

1 Click Print. The Print progress notes 

2 Select whether you are printing the en
specific range of dates. 

3 In the Entries to include section, selec
information to print.

4 In the Output format section, choose 
Transcription labels. 

5 Click OK. The system prompts you wit
previewing the output you selected be
printer. 

6 Select Preview or Print and click OK.
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Skill Sharpeners—Using the Prog Notes Tab

Exercise 1—Attach a Progress Note

You want to attach a note to indicate that you used an anesthetic 
on Jacob Adair during his visit today. 

To create the note:

1 Open Mr. Adair’s chart and click the Prog Notes tab.

2 Click Note, located above the Progress Notes/History 
section of the window. The Note Template Pick List is 
displayed. 

3 Select Anesthetic used, and click OK. A note-specific 
window is displayed. 

4 Use the options on the window to enter variable information, 
and then click OK. The Attach note to patient chart window 
is displayed. 

The Summary, Date, and Note text fields are already filled in. 
You can type additional data in the Note text field. 

5 Click OK. 

Exercise 2—Display a Thumbnail Image

From the Prog Notes tab, display a thumbnail image of tooth #3.

To display a thumbnail image from the Prog Notes tab: 

1 Click the Prog Notes tab. The Progress Notes window is 
displayed. 

2 Click the column header Area to sort the notes by tooth 
number. 

3 Click on the note relating to tooth #3. The thumbnail image is 
displayed in the image viewer near the bottom of the window.
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sson 5

sing the Treatment Plan Tab

is lesson includes:

• Working with Treatment Plans on page 29

• Implementing Treatment Plans on page 30

• Using the Treatment Plan Tab on page 31

• Creating a Treatment Plan on page 32

• Presenting Tx Plans for Acceptance on page 33

• Reviewing a Treatment Plan on page 33

• Submitting Procedures for Pre-Determination on page 34

• Switching Between Tx Plans on page 34

• Copying Procedures Between Tx Plans on page 35

• Entering Appointment Information on page 36

orking with Treatment Plans

treatment plan is a recommended series of procedures created 
 a patient. A patient can have more than one treatment plan, but 
ly one can be accepted and in progress at any given time. A 
tient must give consent for each plan proposed. 

hen you exit a chart, Does the patient wish to accept the 
oposed treatment in plan at this time? is displayed. If you 
lect Yes, the treatment plan status changes to Accepted; if you 
lect no, the status remains Proposed.

A treatment plan is used in the following w

• To present the patient with a cours
of visits, fees, and insurance estim

• To schedule the sequence of appo
complete the treatment.

• To submit to the patient’s insuranc
approval, if applicable.

You can prepare multiple treatment plans f
to present your patient with alternatives. Yo
plans and move procedures from one plan 

The procedures listed in a treatment plan a
appointments for which they are scheduled
in the appointment automatically produces 
treatment plan. 

Treatment plans that are not yet scheduled
the Office Expert and the Unscheduled TxP
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Implementing Treatment Plans

To implement a treatment plan:

1 Use Charting to create one or more treatment plans based on 
the diagnosis of the patient. 

2 Present the plans for approval. While a patient may consider 
alternative plans, only one can be accepted and in progress at 
a time. 

3 If appropriate, print an insurance pre-determination, and then 
enter the results when the company responds.

4 Define the appointments needed to complete the plan. Group 
procedures into appointments, called visits, and define the 
details of each visit.

5 Schedule the procedures.

Note

As procedures are 
completed, they are 
marked complete in 
the treatment plan.
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Using the Treatment Plan Tab

Click the Tx Plan tab, and the Treatment Plan window is displayed.



 plan. The Treatment Plan window is 

 plan name in the Description of plan field. 
 date defaults to 30 days from the current 
dited.

ce Visits button in the upper-right of the 
e visit number, then select each procedure 
ence the procedures until you have a logical 

or the completion of this treatment plan. 

oducer for one or more of the procedures, 
s by the procedure in the Prod column until 
cer’s initials are displayed. 

splays the following: 

ed
nted on <date>
bmit Pre D

XXX on <date>
DA <code> on <date>
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Creating a Treatment Plan

To create a treatment plan:

1 Click the Hard tissue tab. The Hard tissue chart window is 
displayed. 

2 In the Chart Mode section of the window, click Chart 
proposed. While you are in Chart Proposed mode, entries 
made to the hard tissue chart appear in red, and they are 
automatically added to the treatment plan. 

3 Select a tooth, and use the chart buttons to chart proposed 
procedures to the patient’s hard tissues. Repeat for additional 
teeth to be treated. Depending on the procedures selected, 
additional choices may be displayed. For example, if you 
indicate the necessity of a crown, you will be prompted to 
select the material for the crown. 

4 Click the Tx Plan tab. The Select treatment plan to 
view/display in chart window is displayed. 

5 Click Create new
displayed. 

6 Enter a treatment
The fee expiration
date and can be e

7 Click the Sequen
window. Select th
for that visit. Sequ
number of visits f

8 To change the pr
click on the initial
the correct produ

The Status column di

• Not yet print
• Proposal pri
• Waiting to su
• Pre Auth $X
• Performed A

Note

Typically, a Tx plan is 
started from the Hard 
tissue tab. In 
proposed mode, 
chart the treatment 
that needs to be 
completed, and then 
go to the Tx Plan tab 
to set up the plan.

Note

The colors can be 
configured. 
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Look at the status when working with a treatment plan. The Tx plan 
Status column changes as you make selections and choices. 
Hard tissue chart entries display treatment details that appear in 
the Status column. 

Presenting Tx Plans for Acceptance

Before you can schedule appointments for a treatment plan, the 
patient must accept the plan. 

You can print the treatment plan for the patient, or you can show 
the plan on your computer screen. You can present several 
treatment plans, and let the patient choose. While there can be 
several plans for one patient, only one plan can be accepted.

There are four ways to indicate that the patient accepts a plan:

• When you create the treatment plan from Charting and 
close the chart, you are prompted for whether the patient 
accepts the plan.

• From the Treatment Plan Pick List, select the plan and 
click Accept. 

• When you make a new appointment, or double-click an 
existing appointment, for a patient with an unaccepted 
treatment plan, the Treatment Plan Pick List prompts 
you to indicate that the plan has been accepted.

• Treatment plans that are auto-created during the 
scheduling of an appointment are, by definition, accepted.

Reviewing a Treatment Plan

To review another treatment plan for a pati

1 In the patient’s chart, click the Tx Plan
Plan window is displayed. 

2 Click Select new plan. The Select tre
view/display in chart window is disp

The Status with Patient displays one 

• Proposed
• Accepted
• In progress
• Completed

3 Click Select plan. 



tion on the form to make certain it is correct. 
formation as necessary. 

s you want, and click OK. 

een Tx Plans

one treatment plan or want to create another 
n switch between plans from the TxPlan 

eatment plan:

b, click Select New Plan. The Select 
 view/display in chart window is 

 plan by double-clicking it, or by highlighting 
lect Plan. The plan is now displayed on the 
n the Hard tissue tab.
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Submitting Procedures for 
Pre-Determination

If the patient’s insurance company requires pre-determination for 
any procedures in the treatment plan, you can submit the plan for 
approval before scheduling the procedures.

To submit the treatment plan for pre-determination:

1 Click the TxPlan tab. The Tx Plan window is displayed. 

2 Highlight the procedure you want to submit, and click 
Request Pre-D.

3 Repeat for each procedure you want to submit.

4 Click Submit ins Pre-D. The Submit for Predetermination 
window is displayed. 

5 Select Print form on paper now if you want to fax or mail the 
request; select Submit electronically now if your office has 
this capability. The Insurance Submittal Information form is 
displayed.

6 Read the informa
Enter additional in

7 Select the option

Switching Betw

If you have more than 
treatment plan, you ca
tab. 

To select a different tr

1 On the TxPlan ta
treatment plan to
displayed. 

2 Select a different
it and clicking Se
TxPlan tab and o
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Copying Procedures Between Tx Plans

Although you can create multiple treatment plans for a patient, 
only one can be accepted at a time. To create a new or revised 
treatment plan, you can copy procedures of another treatment 
plan and then revise visits in the new treatment plan. 

To copy procedures from one treatment plan to another: 

1 Open or create the treatment plan into which you want to 
copy a procedure. 

2 Click Copy From. The Select treatment plan to 
view/display in chart window is displayed. 

3 Highlight the treatment plan containing
want to copy, and click Select. The Co
Tx Plan window is displayed. It lists th
plan. 

4 Highlight one or more procedures in th
copy. 

5 To change the visit numbers, select Fir
should become visit, and type a visit 

6 Click Copy selected to copy the proce
selected to move the procedures. You
treatment plan that contains the copied



tion button to select the type of 
 appropriate abbreviation is displayed along 
nding treatment class. 

nt producer for this appointment, select 
n list.

o enter the number of Minutes or Units of 
on-production time required for this 

er minutes or units may be used. 

iew the Insurance Estimate calculated by 
 on the patient’s insurance plan. If the 
ave insurance, this button is inactive.

ntry to edit the procedures in the list. 

edure from the list, select the procedure and 
try. A Do you want to defer this procedure 

essage is displayed. If you select No, the 
oved permanently from the treatment plan.

djustments to the appointment information, 
e-calculate to see the revised total cost of 
The system enters that amount into the Est. 
d. 

ired to be returned for the appointment, 
and Lab Case Pending under Lab 
 the Select Lab button to indicate which lab 
ork.

pointment is saved, but not scheduled. 
s in the practice management module.
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Entering Appointment Information

You can enter details about the procedures in the treatment plan 
from Charting. This streamlines the process of scheduling by 
defining the pertinent elements of an appointment, such as 
treatment class, producer, time units necessary, and whether lab 
work is required. 

To enter appointment information from Charting:

1 Click the TxPlan tab.

2 Right-click on a procedure for which you want to add 
appointment information. A short-cut menu is displayed. 

3 Select Appointment information. The Appointment 
Information window is displayed. 

4 Click the Descrip
appointment. The
with the correspo

5 To select a differe
from the drop-dow

6 Click the arrows t
Production and N
appointment. Eith

7 Click Ins Est to v
the system based
patient does not h

8 Click Add/Edit E

9 To remove a proc
click Remove En
to a later date? m
procedure is rem

10 If you made any a
be sure to click R
the appointment. 
production $ fiel

11 If lab work is requ
check Lab Case 
Information. Use
is used for this w

12 Click OK. The ap
Scheduling occur
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Skill Sharpener—Using the Tx Plan Tab

Exercise 1—Create a treatment plan for Jacob Adair.

You have examined Jacob Adair and now you want to create a 
treatment plan. 

To create the plan:

1 Open Mr. Adair’s chart and click the Hard tissue tab. 

2 In the Chart Mode section of the window, click Chart 
proposed. 

3 Select a tooth, and use the chart buttons to chart proposed 
procedures to the patient’s hard tissues. 

4 Click the Tx Plan tab. The Select treatment plan to 
view/display in chart window is displayed.

5 Click Create new plan. The Treatment Plan window is 
displayed. 

6 Enter a name in the Description of plan field. 

7 Click the Sequence Visits button in the upper-right of the 
window. Select the visit number, then select each procedure 
for that visit. 
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sson 6

sing the Attached Images Tab

is lesson includes:

• Understanding the Attached Images Tab on page 39

• Using the Attach(ed) img Tab on page 40

• Attaching Images on page 41

• Importing X-rays on page 41

• Removing Images From a Chart on page 41

• Emailing Images on page 42

nderstanding the Attached Images Tab

e the Attach(ed) img tab to attach images to the patient’s 
art, or to view existing attached images. You can also move an 
age attached to one tooth or area and attach it to another tooth 
 area.

the Hard tissues tab, a camera icon lets you know that the 
tual image resides on the Attach(ed) img tab. If you want to 
w a full-sized image, double-click the image in the viewer to 
nch the CS Imaging software or the Image Editor window. You 
n also make comments on the image.

An image can be any of the following:

• An image from a video source—typ
camera—captured on the Capture

• An x-ray imported directly from one
systems integrated with the Practi

• An image that was imported from 

• Document images acquired with a
typically a scanner or digital still ca
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Using the Attach(ed) img Tab

Click the Attach(ed) img tab, and the Attach Images window is displayed.
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is required to delete 
images.
PracticeWorks Charti

Attaching Images

To attach images to the patient’s chart:

1 Acquire new images. The images in the viewer displayed on 
the Capture tab. 

2 Click the Attach(ed) img tab. 

3 Make sure the Show All Image Types option is selected.

4 Make sure the Unattach button is highlighted. Images not 
attached are displayed in the Image Viewer at the bottom of 
the tab.

5 Drag and drop an image on a tooth, mouth area, portrait area, 
or document area to attach it to that area. On the tooth chart, 
a small camera icon is displayed near the tooth or an asterisk 
is displayed in the mouth area to show that one or more 
images are attached. The portrait area is large enough to 
display the image, so no icon is needed.

6 Continue to attach images as needed. There is no limit to the 
number of images you can attach to any area; the portrait 
area, however, shows only the most recently attached image. 

7 To see more images in the Image Viewer area, use the scroll 
bar.

When you attach an image, the type of image, the tooth # or area 
name, and the date it was attached are displayed as a caption 
under the image.

An entry is made in the Prog Notes tab for each attached image. 
The note indicates whether it is a Generic Image, X-ray, or 
Camera Image.

Importing X-rays

Images acquired with the CS Imaging softw
imported and attached, depending on how
the imaging software.

Click Import X-rays to import x-rays from c
When the image is imported, it is attached
Image Viewer. 

You can also use the Microsoft Windows C
functions to import x-rays from other progra

Removing Images From a Ch

To remove an image from a chart:

1 Click the Prog Notes tab. 

2 Select the appropriate entry, and click 

3 Select Remove Entry and click Make 
deleted here are not displayed when y
tabs.
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Emailing Images

To create an email message with attached images from Charting:

1 Select the image you want to attach to the email by 
right-clicking on it in the Image Viewer. A short-cut menu is 
displayed.

2 Select Send Image via E-mail. An email message is 
displayed with the images represented as file attachments. 
The following information is included automatically in the body 
of the message:

• Practitioner’s name
• Patient’s name
• File name
• Image date

3 Type the email address of the recipient and the text you want 
to include in the body of the message, and click Send.

Note

If you are emailing an 
image captured in CS 
Imaging software, the 
email also includes a 
link for the recipient to 
download the image 
viewer.
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Note

If you are emailing an 
image captured in CS 
Imaging software, the 
email also includes a 
link for the recipient to 
download the image 
viewer.
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Skill Sharpener—Using the Attach(ed) 
Images Tab

Exercise 1—Attach and email images.

You want to attach images to a patient’s chart and email the 
images.

To attach and email images of Jacob Adair:

1 Open Mr. Adair’s chart and click the Attach(ed) img tab. 

2 Select the Show All Image Types option.

3 Make sure the Unattach button is highlighted. Images not 
attached are displayed in the Image Viewer at the bottom of 
the tab.

4 Drag and drop an image to attach it to an area. To see more 
images in the Image Viewer area, use the scroll bar.

5 Right-click the image in the Image Viewer. A short-cut menu 
is displayed.

6 Select Send Image via E-mail. An email message is 
displayed with the images represented as file attachments.

7 Check the following information in the body of the message:

• Practitioner’s name
• Patient’s name
• File name
• Image date

8 Type the email address of the recipient and the text you want 
to include in the body of the message.

9 Click Send.
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sson 7
sing the Capture Tab

is lesson includes:

• Understanding the Capture Tab on page 45

• Using the Capture Tab on page 46

• Capturing Intraoral Images on page 47

• Capturing Images from TWAIN Devices on page 47

• Importing Images from Digital Cameras on page 48

nderstanding the Capture Tab

e Capture tab enables you to capture images from external 
vices and place them in a patient’s chart. These images can 
me from x-rays, extraoral and intraoral cameras, digital cameras, 
d scanners. Using the Capture tab and the Attached Images 
 together, you can capture images and attach those images to 

ecific teeth or areas of the mouth. 

e the Capture tab to capture images from most Audio Video 
erleave (AVI) compatible video sources. AVI is a standard used 
 many video devices, capture cards, some stand-alone video 
meras, and so forth. Of course, your video capture card must be 
mpatible with PracticeWorks.

e the External application button to launch any of the other 
ograms which are integrated with PracticeWorks.

When you click the Capture tab, the syste
begin capturing now. 

• Click Yes if you want to go immed
mode.

• Click No if you want to open the ta
images right now. On the tab, you 
mode at any time by clicking Capt
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Using the Capture Tab

Click the Capture tab, and the following window is displayed. 
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Tip
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Capturing Intraoral Images

To acquire images from your intraoral camera, connect the camera 
to your computer as instructed by the camera’s manufacturer and 
follow these steps:

1 Start capture mode by clicking Yes when the Start capturing 
now? message is displayed, OR click the Capture button at 
the bottom of the Capture Tab window. The cursor changes 
to a cross, and the message Press Esc to stop indicates you 
are in capture mode. 

2 When a image from your camera is displayed that you want to 
capture, click the mouse button. The image is displayed on 
the Capture Tab window.

3 If you are dissatisfied with the image you captured, right-click 
on the image to discard it. You are returned to the live view, 
and you can resume capturing. 

4 To save an image, click the mouse button again. The image is 
displayed as a thumbnail on the Image Viewer. 

Capturing Images from TWAIN Devices

TWAIN refers to a programming standard for acquiring images 
from such devices as scanners, digital still cameras, and so forth. 

To acquire images from TWAIN devices:

1 On the Capture tab, click External application. A window is 
displayed giving you these choices:

• Twain Quick Scan
• Twain Advanced Scan

If you have more than one TWAIN device installed, a list is 
displayed.

2 Select a device from the options listed

3 Repeat the steps as required. The mos
image appears in the upper-left corner
To view all images, scroll down.

4 When you have finished capturing ima
Attached Images tab opens. You can
images to the patient’s chart. 

You can return to the Capture tab at a
images. Images that were saved as thu



riate directory, and click Open. 

. 

era list, select Delete Images from 
porting. 

 use the drop-down list to select No or Yes. 
ses the images from your camera; No does 
ntry. 

t to close the Configuration window.

s

 a digital camera:

 tab. The Capture Tab window is displayed.

era. The Digital Camera Import window is 

nt import directory, click Browse. 

you want to import. Images are highlighted 
r. 

ges. The images are imported and displayed 
er.

d the images into a patient’s chart, you can 
 tooth or area of the mouth by right-clicking 
ng Edit image information. 
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Importing Images from Digital Cameras

The Capture tab enables you to import images directly from your 
digital camera into the patient’s chart. Before you can do this, you 
must configure the import option in the Configuration window.

Configuring the Import Directory

To configure the software to import images from a digital camera:

1 Click Start > All Programs > PracticeWorks > 
Configuration of PracticeWorks. The Configuration of 
PracticeWorks window is displayed.

2 Click Setup > General Configuration. The General 
Configuration window is displayed. 

3 Click the plus sign next to Integration, and a submenu is 
displayed. 

4 Click the plus sign next to Digital Camera, and then select 
Import Directory. Settings for this workstation is selected 
by default. 

5 Click Browse, and navigate to the directory associated with 
your digital camera’s card reader. 

6 Select the approp

7 Click Save Entry

8 In the Digital Cam
Camera after Im

9 In the Value field,
Selecting Yes era
not. Click Save E

10 Click Close.

11 Select File > Exi

Importing Image

To import images from

1 Click the Capture

2 Click Digital Cam
displayed. 

3 To select a differe

4 Click the images 
by a green borde

5 Click Import Ima
in the Image View

After you have importe
associate them with a
the image and selecti

Note

The import directory 
for digital camera must 
be configured for each 
workstation. 

Note

See your camera 
manufacturer’s 
documentation about 
connecting your 
camera to your 
computer.

Note

To import images from 
a digital camera, the 
camera must be 
connected via a USB 
port and turned on 
before importing. 
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Skill Sharpener—Using the Capture Tab

Exercise 1—Preview an Image

Preview the image of Ray Adkins’s tooth #30 on the Capture tab. 
After you have previewed the image, close it. Then open and close 
the image again. 

To preview an image:

1 Click the Capture tab. The Capture window is displayed.

2 In the Image Viewer section of the window, find the 
thumbnail for tooth #30, and click it. The thumbnail is outlined 
in red. 

3 Right-click on the thumbnail. The menu is displayed. 

4 Select Preview. A larger version of the image is displayed. 

5 To close the Preview window, click the X.

To open the image, and then close it:

1 Double-click on the thumbnail in the Image Viewer. The 
Image Editor window is displayed. 

2 To close the Image Editor window, click the X.



50 of 50  PracticeWorks Charting Module Training Workbook (DE255-05)



g Module Training Workbook (DE255-05)  51 of 58

Le

U

Th

U

Us
to
sin

W
the

 more images than can 
s can be viewed by 

ow called the Preview 
ttons representing the 

 the way one or more 

layed in the Preview 
ed to as a pane. 

button. 
PracticeWorks Chartin

sson 8

sing the Layout Tab

is lesson includes:

• Understanding the Layout Tab on page 51

• Adding Images to the Preview Window on page 53

• Deleting Images on page 54

• Printing an Image Layout on page 54

• Annotating Images on page 54

nderstanding the Layout Tab

e the Layout tab to organize, view, and print different images 
gether. You can also integrate x-rays and intraoral images into a 
gle case presentation.

hen you click the Layout tab, existing images are displayed in 
 Image Viewer on the right side of the window. 

An active scroll bar indicates that there are
be displayed at one time. Additional image
scrolling. 

Most of the Layout tab is a large blank wind
window. Below the Preview window are bu
various layouts available to you. A layout is
images can be arranged and displayed. 

Click a layout button, and that layout is disp
window. Each section of the layout is referr

To change a layout, click a different layout 



52 of 58  PracticeWorks Charting Module Training Workbook (DE255-05)

Layout Tab

Click the Layout tab, and the following window is displayed. 
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he layout, right-click on 
t menu is displayed. 

 image is displayed. 

 click the X in the 

Note

You can drag more 
than one image at a 
time to the Image 
Viewer as long as 
multi-select mode is 
enabled. To enable, 
right-click on any 
image in the Image 
Viewer and click 
Multi-select mode.
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Adding Images to the Preview Window

The Image Viewer enables you to preview, access, and annotate 
any of the images associated with a patient. The Image Viewer is 
available on the Hard tissue, Soft tissue, Capture, and Layout 
tabs of Charting. 

After you select a layout, drag images one at a time from the 
Image Viewer to the appropriate pane of the layout on the 
Preview window. Each pane can contain a single image. An image 
may be dragged from one pane in the layout to another pane. The 
layout may contain any mix of images, regardless of source. 

If you add a single wrong image to the layout, right-click the pane 
with the wrong image, and select Clear. Or you can right-click and 
select Clear All, and the layout and all the images you added are 
cleared.

Keep the following points in mind when designing your layout: 

• Replace an image by dropping a different image over the 
existing image. 

• If you do not want annotations to display, deselect the 
Annotations option beneath the layout buttons.

• To add or edit annotations, double-click on a thumbnail 
image, and the Image Annotations window is displayed.

You can start with one layout and change to another. For example, 
if you select a layout with four image panes, you can place four 
images there. If you switch to a layout with two image panes, only 
the top two images will display. If you then switch back to a four 
image layout, the software remembers the original four images and 
places them correctly. 

To preview an image before dragging it to t
the image in the Image Viewer. A short-cu

Select Preview, and a larger version of the

To close an image that you are previewing,
upper-right corner of the preview.



 Image

e:

 thumbnail of the image you want to 
 is displayed. 

 The Image Editor window is displayed. 

e cursor to draw a text box on the image. A 
which you can type text. 

e box. 
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Deleting Images

To delete an image: 

1 Right-click the thumbnail of the image you want to delete. A 
menu is displayed.

2 Select Delete. The Delete Image Verification window is 
displayed. 

3 Click Yes to delete.

If your office uses CS Imaging software, deleting an image from 
Charting also deletes it from the imaging software. 

Printing an Image Layout

To print an image layout, click Print on the Layout tab. 

When you print your layout, the patient’s name, date, and time of 
printing is printed automatically in the lower-left corner of the 
page.

Annotating Images

If your office uses CS Imaging software and you select Annotate, 
the image opens in the CS Imaging Annotation window.

Annotations can take the following forms: text, shapes, or 
measurements. 

Adding Text to an

To add text to an imag

1 Right-click on the
annotate. A menu

2 Select Annotate.

3 Click Text. 

4 Click and drag th
window opens in 

5 Type the text in th

Note

Deleting an image 
requires level 10 
security. 
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Note
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mode for the Shapes 
button or the Ruler 
button to be 
displayed.
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6 Click Save. . 

Adding a Shape to an Image

To add a shape to an image:

1 Click the Shapes button.  

The Image Editor window is displayed again with a list of 
shapes from which to choose on the right side of the window. 

2 Select the shape you want to use. 

3 In the attributes section of the window, select the Line Color 
and Line Size that you want. 

4 Click and drag the cursor to draw the s

5 Click Save. 

Adding Measurements to an Imag

To add a measurement to an image:

1 Click the Ruler button. 

The Image Editor window is displayed
Measurement Tools displayed on the
window. 

2 Select the tool you want to use.



56 of 58  PracticeWorks Charting Module Training Workbook (DE255-05)

3 Select the Tool Color and Tool Line Size.

4 Click and drag the cursor across the area for which you want 
a measurement displayed. Click outside the area when you 
have finished.

5 Click Save to save the image with annotations.
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Skill Sharpener—Using the Layout Tab

Exercise 1—Annotating an Image

Annotate the photograph of tooth #30 of Ray Adkins. Indicate that 
the filling is breaking down. Draw a text box near the area of 
concern to type the text annotation.

To annotate an image:

1 Open the Image Preview window.

2 Right-click on the image of tooth #30. A short-cut menu is 
displayed. 

3 Select Annotate. The Image Editor is displayed. 

4 Click the Text button beneath the photograph. 

5 Click and drag to draw a text box on the image. When you 
release the mouse button, the text box is displayed with the 
words Your Text Here. 

6 Type Filling is broken. 

7 Click anywhere outside the text box. The text annotation is 
displayed. 

8 Click the Shapes button beneath the photograph. 
The shapes available are displayed to the right of the window. 

9 Select Pointer. The cursor changes to a cross.

10 Drag a line from the area of concern in the filling to the 
annotation. The arrowhead of the pointer is located where you 
click first.

11 Click outside the arrow. The annotated image, with text and 
pointer, is displayed on the photograph. 

12 Click Save.
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